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Technical requirements

Microsoft Dynamics 365 Business Central

1. Understanding the VPS

Since the VPS is a Gantt chart, it naturally has all its characteristics:

Jan 25, 2021 Jan 26, 2021 Jan 27, 2021 Jan 28, 2021 Jan 29, 2021 Jan 30, 2021 Jan 31, 2021
Production Orders
12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM| 12:00 PM| 12:00 AM[ 12:00 PM| 12:00 AM| 12:00 PM

) 109001 (Bicycle) ™ ¢
4 Firm Planned
4 1010005 (Bicycle) 4 | [ )
4 10000 4 ) | ¢
10 (Wheel assembly)
20 (Chain assembly)
30 (Final assembly)
40 (Contral) ﬂ
p 1011002 (Bicycle) P | ¢

e Atimescale at the top.

e Atable at the left, production orders (in the Production Order View) or work and machine
centers in the Resource View

e On the right below the time scale, a chart displaying the production schedule with a calendar in
the background indicating work free periods in grey while working times appear in white.

e A menu ribbon allowing to make basic settings that will be explained in detail in the following.

Visual Production Scheduler:  All | NETRONIC VPS ~ Open in Excel | Actions~  Fewer options

The item “NETRONIC VPS” summarizes the options that we think are the most frequently used
ones:

NETRONIC VP5~  Page ~

BE Reload
H Save
Capacity View
88 Production Order View

[# Setup

é':'I:I NETRONIC pacE 3 oF 39
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All options of the VPS can be found under “Actions”:

Actions~  Fewer options

| General
View Filter
Calendar
Timescale
Capacity Aggregation
View

Administration

b

In case the “Actions” item is not visible in the menu ribbon, click “More options”. To hide it again,

click “Fewer options”.

|

was last updated.

= NETRONIC

A vertical line in the chart indicates the work date as having been set in Dynamics 365 Business
Central.

A blue dashed line indicates the time when your plan

paGE 4 oF 39
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2. Three different views

There are three different views in the VPS: The Production Order View, the Capacity View, and the
Histogram View. You can switch between them by using the corresponding menu items:

Actions Fewer options
General b
View Filter b
Calendar >
Timescale >

Capacity Aggregation >

View > Capacity View
Administration » B8 praduction Order View

il Histogram View

2.1. The Production Order View

Mo, Jan 25, 2021 Tu, Jan 26, 2021 We, Jan 27, 2021 Th, Jan 28, 2021 Fr, Jan 29, 2021

Production Orders

06:05 Al 12:00 PM 12:00 AM 12:00 AM 12:00 AM

4 109001 (Bicycle)

=

» 10000 g
4 Firm Planned D

p 1010005 (Bicycle) | 4 a1

4 1011002 (Bicycle) | 4 a |

4 10000 L 4 1

10 (Wheel assembly) :

20 (Chain assembly)

30 (Final assembly)

40 (Control)
» 1011003 (Bicycle) L4 1
p 1011004 (Bicycle) | 4 1

é':'I:I NETRONIC paGE 5 oF 39
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The Production Order View shows production orders categorized by status; the categories being

indicated by different colors:
p Firm Planned

2.1.1. Sorting

Production orders, their production order lines, and production order routing lines are sorted in
ascending numerical order.

Within each production order, the relating production order lines with their production order
routing lines are listed.

This sorting order can be changed in the according dialog which can be opened either by context
menu or in the “Configuration”s tab of the user setup.

X

Edit - Define Configuration 7

O Search -+ New E% Edit List [i] Delete A Move Up ¥ Move Down £ Open in Excel

Machine Center

Table Name Field Name Ascending Descendi...

— Machine Center |Namel | O

2.1.2. Information shown on bars

The following information can be gathered from optical indicators:

e Currently marked operation:

e Operation changed but not saved yet

e Violated due date

§ NETRONIC paGE 6 oF 39
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2.1.3. Links

Links are shown after having clicked the desired production order or production order line as

described below:

e between operations of one production order line

e between production order lines (make-to order)

» 40000 —:

20000 *
» 30000 *

You can decide whether to show these links or not by ticking/unticking the according option

in the “General” section of the “Setup” dialog.

Gemeral
Pregridd Caleulitian Badad o Tista
Shezew Parrtial Frial Ovaber Lissks .

e between production orders

.4 101010 (Front Hub) Lg

Shére Links Esptmaten Prod. Chrdkes Liced

4 10000 Lg

10 (Drilling Machine)

20 (CNC Machine)
30 (Machine Deburm) j\
20 (Drilling Machine)

5 (CNC Machine) C|

50 (Assembly department)

60 (CNC Machine)

4101020 (Front Wheel)

4 10000

10 (Assembly department)

= NETRONIC

paGE 7 oF 39




DOCUMENTATION VISUAL PRODUCTION SCHEDULER

2.1.4. Due date

The due date of a production order is represented by a diamond-shaped symbol, turning red in case
of an exceeded due date.

2.1.5. Progress

Based on the settings you have specified in the "Setup" dialog, you can display a progress bar for
production order routing lines of released production orders, the color of the progress bar
depending on the routing status and the percentage of completion:

e Status “finished”: black

n

e Status “none”, “planned”, “in progress”:

o Progress by quantity / by time < 100%: grey

o Progress by quantity / by time (i.e., you have posted more than initially planned) >
100%: red

= NETRONIC

pAGE 8 oF 39
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2.2. The Capacity View

Visual Production Scheduler:  All -~ | NETRONIC VPS ~~ Open in Excel Actions Fewer options

il

Ebmaly 2021
Capacities k 05

il

4 Machining

il 4 Cutting @

Shows/hides the capacity curve

Cutting #1 »

P18 1 @ i@ 1@
i | | 0

e Shows capacity loads of work centers and machine centers, grouped by work center groups.

e Capacity bottlenecks and conflicts concerning delivery dates can be visualized by a red box in the
capacity curve and by according symbols in the table part.

The meaning of the symbols in detail:

o B No overload at the parent resource (group) but at one or more subordinate
resource(s)

o il Overload at the resource (group) itself and at one or more subordinate
resources
o @1 overload only at the resource (group) itself

Please note that if there isn't any overload in the complete plan the symbol column will not be
shown.

e The bars of the operations are colored during working times and white during non-working
times.

[1011[14:14

e The bars get different colors according to the different categories of the Production Order

View.

p Firm Planned

2.2.1. Information shown on bars

The following information can be gathered from optical indicators:

é':'I:I NETRONIC pace 9 oF 39
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e Currently marked operation:

o |
e Operation changed but not saved yet

e Violated due date

(I

2.2.2. Links

Links between operations are shown after having clicked one operation of the
according production order.

2.2.3. Due date

If you click an operation, a vertical line in the color of the operation's status appears, indicating the
due date.

Due date 'IJ'I 1002 I

é:': NETRONIC pace 10 orF 39
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2.2.4. Setup times

A context menu enables to show or hide the setup times

b
[
L

101009
Shimy Setup Times

Hige Setup Times

If “Show Setup Times” is selected, they are visualized as grey section at the beginning of the bar

"
L
I
L

fio1009

2.3. The Histogram View

A histogram offers visual decision support by showing impending capacity problems. In the
Histogram View, the histograms of the work centers and their respective machine centers are
displayed.

Overloads at a resource are indicated by a red box in the chart and according symbols in the table
part.

. January 2021 February 2021
Histogram
Wk 03 Wk 05
il 4 Machining

0.0

6.791
il 4 Cutting

. =
0 3763

Cutting #1
1.584 . -
0 e |
[ i 4773
Cutting #2
2387
0 I =

The meaning of the symbols in detail:

e # nNooverload at the parent resource (group) but at one or more subordinate resource(s)

. M Overload at the resource (group) itself and at one or more subordinate resources
e & overload only at the resource (group) itself

Please note that if there isn't any overload in the complete plan the symbol column will not be
shown.

é':'I:I N ETRONIC pace 11 or 39
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3. Show/hide non-working periods
Some planning situations require to focus on the working periods of a work or machine center only.

To show or hide non-working periods, click the "Calendar" item in the "Actions" menu and select the
desired option.

Actions v Fewer options

General
Feb 05, 2021
g Calendar > | & Show Norl\-working Periods
Timescale > X Hide Non-woarking Periods

Administration > | -

After having selected "Hide non-working periods", you'll only see the non-working periods that are
unique to some work and machine centers.

B lan Q Jons 27, 2020 Jan 28, 200N Jans 29, 2000
Capacities ! | J
h 04RO 1200 M ! O 1200 Py O 1200 P
Tumn #1 » [t010}
Ml B Tum C (io7d (1670 foroes oroosT A
; i)
4 Painting »
Painting Cabin » (107030  [ibicoa” figvoez | it
[fot017 ] iocce ]
Paieing Rbot ’ [101070° (161003
notonf lowos
Dning Cabin , o o o0 .
Painting inspection » fioy (i1} o1 01§
(101008 ]
4 Assacnbly & QA |
b Assembly » (iigjioro: oo 1) 5
» QA ’ (foico 4 fibron] LB | g} (S |
(15 i} fioress |
i

§ N ETRONIC pace 12 or 39
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4. Open Microsoft Dynamics 365 Business Central dialogs

The VPS fully integrates with Microsoft Dynamics 365 Business Central. This means that by double-
clicking the according element (production order, production order line, production order routing
line, work center etc.) either in the table area or in the Gantt area, you'll directly switch to the
according Dynamics 365 Business Central dialogs where you can navigate and make changes as usual:

Double-clicking a production order routing line...

10 (Wheel assembly)

4 10000 pr—
10

...will call the according dialog:

Manage Process Order Show Attached Page More options
EDIT - FIRM PLANNED PROD. ORDER - 1010005 - BICYCLE /‘
General =
<
MNo. 1010005 Search Description BICYCLE
Description Bicycle Quantity 16
Description 2 Due Date 30.01.2021 o
Source Type Item v Assigned User ID w
Source No. 1000 4 Last Date Modified
Lines Manage More options
UNIT OF
STARTING ENDING DATE- MEASURI
ITEM NO. DUE DATE DESCRIPTION DATE-TIME TIME QUANTITY  CODE
1000 = 30.01.2021 Bicycle 26.01.2021 10:04  29.01.2021 16:00 16 PCS

= NETRONIC
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5. Collapsing and expanding

4 )
The VPS allows to view your data from different angles easily and quickly. The symbols inthe
table allow to collapse and expand production orders, work center groups, work and machine
centers, thus hiding details or rendering them visible.

Please note that the VPS autmatically saves the collapsed/expanded state of a view so that you can
start exactly with the status you saw when you left the view.

All order categories collapsed:

[ January 2021 February 2021

Activities

Wk 06 Wk 07

} Planned

» Firm Planned

After having expanded the “Planned” category with order 109001 and all its sub-operations:

Activities

Th,| Fr, Jan 29, 2021 Sa, Jan 30, 2021 Su, Jan 21, 2021
08:1 12:00 AM 12:00 PM 12:00 AM 12:00 PM 12:00 AM 12:00 PM

4 Planned

4 109001 (Bicycle)

1]

4 10000

> -

10 (Wheel assembly)

20 (Chain assembly)

30 (Final assembly)

40 (Control)

» Firm Planned

é:': NETRONIC pace 14 or 39
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6. Capacity information

In the VPS, you can show a capacity curve in the Capacity View, to see free and exceeded capacities,
a red box in the capacity curve and by according symbols in the table part indicating an overload.

The meaning of the symbols in detail:

o &l Nooverload at the parent resource (group) but at one or more subordinate
resource(s)

. Wl Overload at the resource (group) itself and at one or more subordinate resources

e B/ overload only at the resource (group) itself

Please note that if there isn't any overload in the complete plan the symbol column will not be
shown.

Visual Production Scheduler:  All -~ | NETRONIC VPS ~~ Open in Excel | Actions Fewer options

il

Ebmary 2021
Capacities k 05

il

4 Machining

il 4 Cutting @

Shows/hides the capacity curve

Cutting #1 »

FIE ) @ e @
o | @ 1

o
© i @

x

The capacity curve combines information on a resource's allocation and its availability. If, for
instance, a task's duration is 10 hours, the capacity curve of a resource with an availability of 8
hours/day shows an overload - if it is calculated per day.

In many cases, the planner regards a resource's availability by week or even by month. That is why
the VPS lets you select whether you do the capacity calculation either by second, day, week, or
month. The curve will aggregate the occupancy on the selected period.

é':'I:I N ETRONIC pace 15 or 39
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Open in Excel Actions~  Fewer options
] General >
: View Filter >
Calendar >
Timescale >

Capacity Aggregation > B By Second

View > By Day
—  Administration > W By Week ]
. B9 By Month

7. Navigation in the VPS

Navigating in the VRV largely comprises setting the time range for which parts of your plan are
shown, modifying the timescale solution and quickly scrolling to certain parts of your plan.

7.1. Setting the timeframe

The timeframe specifies the time range covered by the timescale, either fixed by absolute values or
relative to the workday. This is done in the “Setup” dialog, to be reached by clicking the “General”
item in the “Actions” ribbon.

e
"

E EDIT - VISUAL PRODUCTIOM SCHEDULER SETUP - ADMIN :!7'
-

i Timeframe Type

E Starting/Ending Date Input Type Relative date ¥

b

-

¢ Timeframe

E ABSOLUTE VALUES RELATIVE WALUES

E Starting Date 12/31,2020 Starting Date -4W

E Ending Date 4/28/2021 Ending Date +3M

é':'I:I NETRONIC pace 16 or 39
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7.2. Change the timescale resolution

For zooming in a certain area of your plan or to zoom out for a better overview, you can change the
timescale resolution either by

e scrolling the mouse wheel in the timescale area
e or, more specifically, by the corresponding items of the “Actions” menu, based on the work date
as having been specified in the settings of Dynamics 365 Business Central.

Actions~  Fewer options

General
2021 Mo, 25. Jan 2021
b0 View Filter 12:00
Calendar
Timescale > | #8 Fitinto View
B Capacity Aggregation ¥ Scroll to Workdate | |
View Scale to

w Administration

7.3. Scrolling

The VPS offers the following options for quickly navigating to certain positions in the diagram:

e the common scrolling options by vertical and/or horizontal scrollbar

e dragging the timescale either right or left

e scroll directly to the Dynamics 365 Business Central work date by selecting the corresponding
item from the “Actions” menu.

Actions~  Fewer options

General e

View Filter b

Calendar b

Timescale > .ﬁ Fit into View -
View > |¥ Scroll to Workdate
Administration > Scale to >

é':'I:I NETRONIC pace 17 or 39
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7.4. Fitinto view

Select this item from the “Timescale” item in the “Actions” menu to switch directly to the timescale
as defined in the “Setup” dialog.

7.5. Adjust the width ratio between table and diagram

For adjusting the width ration between table and diagram, put the mouse cursor on the sash
between the two parts and drag the double arrow appearing then.

Th, Jan 28, 2021 Fr, Jan 29, 2021

Production Orders

01:14 AM 12:00 AM

4 109001 (Bicycle)

11

4 10000

7.6.  Show operation in other view

Show the currently marked operation in the respective other view while it gets highlighted by a
blinking frame.

Show Operation in Capacity View

7.7. Search function
In both views, you can search for production order lines and operations.

The respective view automatically scrolls to the first search result - the operation (for production
order routing line) or the first operation of the production order line. The first found operation is
highlighted by a blinking frame and gets selected, so that the links are shown. If a view filter is active
the search dialog will only show the visible elements in the VPS.

§ NETRONIC pace 18 or 39
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Actions ~~ Fewer options

General ?
View Filter 2 .
_ Search > % Search Production Order Line

_ Calendar > {# Search Operation

Timescale ?

Capacity Aggregation > Jr———
| View S . —
| Administration 2

é':'I:I N ETRONIC pace 19 or 39
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8. Move operations

You can move operations by mouse either horizontally or vertically, each way having a different
impact.

8.1. Move operations horizontally by drag & drop

To schedule an operation, you can move it horizontally along the time scale in the Production Order
View as in the Resource View: As a consequence, the operation will be worked off at a different time.

26/01/2021 15:36,00

& 2021 7 5:35:59
FA01/2021 ° 5:35:5

8.2. Assign an operation to another resource

In the Capacities View, an operation can also be moved vertically when scheduled — to a different
work or machine center. As a consequence, the operation will be worked off by the work or machine
center it was moved to. While moving the operation, a “phantom” bar will remain at the original
place until the mouse will be released.

Mike Seamans » 105 =
|

(1011002
oo |
N orions |

Bryan Walton b |[1011004 | @N—-@

» PR oo

[1011003 |
[1011001 |

4 Packing department »

§ NETRONIC pace 20 or 39
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8.3. Schedule predecessors/successors

If moving an operation shall also affect its linked preceding and/or succeeding operations to the
effect that they are moved accordingly you can make the according setting in the context menu.

|
Show Operation in Capacity View

Schedule Predecessors

Schedule Successors

Restore to Initial Values

Please note that if you want these links to be taken into account for scheduling, you have to tick the
“Schedule across Production Order Lines” option in the "Scheduling" section of the “Setup” dialog.

Scheduling

AUTDSCHEDULE WITH ZEROQ BUFFER TIME

Predecessors

Successons

0|8 0

Schedule Across Prod. Order Lines

9. Consider the queue time in the scheduling algorithm

The VPS allows to consider the queue time that is set on the machine/work center card in 365 BC.

Scheduling

Unit of Mexsure Code MINUTES . Shop Calendar Code 1

Capacity 3 Cueus Time 120
Efficiency 100 Queve Time Unit of Meas. ... |M|N.|'Es§ - |
Consolidated Calendar :.::'

Setting a queue time has no impact on the load of a work/machine center but causes the starting
time of the operation to be moved forward. It can be seen as a buffer time between an operation
and its successor so that you create a gap between the end time and the start time of two
consecutive operations:

é':'I:I NETRONIC pace 21 or 39
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The option can be activated in the VPS setup dialog:

EDIT - VISUAL PRODUCTION SCHEDULER SETUP - ADMIN I/'

AUTOSCHEDULE WITH ZERO BUFFER TIME

Predecessors o
Successors [ @]
Schedule Across Prod. Order Lines @
Conflict Handling of Reservations Decide T
Consider Queue Time &
Consider Send Ahead Quantity [ @]

10. Consider the send-ahead quantity

In Business Central, the user can specify a send-ahead quantity for an operation when defining a
routing. The send-ahead quantity can be used to start a dependent operation before the current
operation is fully completed,

The VPS algorithm tries to avoid any gaps of nonproductive periods on the successor of an operation.
By that, the following operation may start later than expected, but therefore has a continuous
workload. This reduces the overall runtime of the production order line because the operations then
start to overlap. The successor does not have to wait until the predecessor finishes and hence has no
idle time.

é:': NETRONIC pAGE 22 oF 39
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The option can be activated in the VPS setup dialog:

EDIT - VISUAL PRODUCTION SCHEDULER SETUP - ADMIN

AUTOSCHEDULE WITH ZERO BUFFER TIME

Predecessors -
Successors &
Schedule Across Prod. Order Lines @ )
Conflict Handling of Reservations Decide
Consider Queue Time a
Consider Send Ahead Quantity a

11. Restore to initial values

In case you have made changes to an operation, not yet saved your plan, and want to restore the

original values again, click the according context menu item.

Show Operation in Capacity View |

Schedule Predecessors

Schedule Successors

Restore to Initial Values

= NETRONIC
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12. The “Setup” dialog

The “Setup” dialog allows to customize basic settings
2 Setup of the Visual Production Scheduler. You reach it via
“Actions” -> “Administration”.

Here you can make or see the basic settings for:

12.1. Timeframe:

- Specify the timeframe that sets the time range covered by the timescale, either fixed by
absolute values or relative to the workday (see also .6.1, “Setting the timeframe).

Timeframe Type

Starting/Ending Date Input Type Relative date v
Timeframe

ABSOLUTE VALUES RELATIVE VALUES

Starting Date 12/31/2020 Starting Date -5D

12.2. General

- Choose whether to display a progress bar for production order routing lines
of released production orders, based on quantity or time.

- Show links between production order lines: You can decide whether you want
dependencies to be illustrated by links in production orders with more than one production
order lines or not. Tick or untick the according option.

- When, by setting filters, a single operation of a PO line gets filtered out, the standard
procedure in the VPS is to only visualize the complete PO line. By unticking the option, you
can switch to visualizing also a partial PO line.

- Decide which view is shown upon starting the VPS. No matter which view you select, the
following settings get saved upon closing the VPS and are active the next time it gets started:

o Show/hide setup times
o Show/hide work free periods
o Histogram aggregation

é‘z'luzl NETRONIC paGe 24 oF 39
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General
Progress Calcul... | Based on Quantity ¥ Show Links bet... &
Show Partial Pr... [ @) Startup View Last Active View v

Last Active View
Prod. Crder View

Capacity View

12.3. Scheduling

- Determine whether or not predecessor operations should automatically be re-scheduled
when an operation is modified.

- Determine whether or not successor operations should automatically be re-scheduled when
an operation is modified.

- Determine whether dependencies between several production order lines of a
manufacturing order are to be taken into account for the automatic planning.

- Users can decide how they want to handle conflicts between existing reservation entries
and drag and drop actions they make in the planning board.

@)

Warn and Reject: The message informs about the conflict, and then the drag & drop
action is rejected. That way, the users cannot violate any existing reservation with
the VPS.

Decide: The user receives a message about the conflict and can decide whether to
cancel or confirm the interaction. If the action gets confirmed, the conflicting
reservation will be removed.

None: No warning is giving about possible conflicting interactions and the conflicting
reservation will be removed.

Consider queue time: Decide whether the queue time specified in Business Central
on the work/machine center card is to be considered for the scheduling process.
Consider send-ahead time: Decide whether the send-ahead time specified in
Business Central on the work/machine center card is to be considered for the
scheduling process.

Scheduling

AUTOSCHEDULE WITH ZERO BUFFER TIME

Predecessors

SuUCCessors

Schedule Across Prod. Order Lines

Conflict Handling of Reservations Warn and Reject bl
wWarn and Reject

Consider Queue Time Decide
None

Consider Send Ahead Quantity

I80
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12.4. Filter

- You can determine whether the "Data filter" dialog comes up on starting the VPS or not.
Please note that if you decide to not have it shown, the last selected data filter will be
activated.

- The last selected view filter can be applied when the VPS is started.

12.4.1. Data Filter

- See which data filters are currently active.

Filter

Show Data Filte... @ ) Enable Last Use.. (D
Data Filter

Current Data Fil... Freigegeben Machine Center...

Work Center Gr... Production Ord...

Work Center Fil..

12.5. Appearance

Appearance
Zoom Factor(%) 100 Selection Color #ffa000
Layout STANDARD e Tooltip Delay (ms) EODCI |

- Specify a zoom factor in percent.
- Choose a layout: In the "Compact" layout, the display is reduced as much as possible to
provide a better overview, especially with large plans.

Standard layout:

= NETRONIC
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bn Jan 25, 2021 Jan 26, 2021 Jan 27, 2021 Jan 28, 2021 Jan 29, 2021 w Jan 30, 2021

Production Order

4 101033 (1 Operation Simple Subcg

J

4 10000

10 (Subcontracting)

4 Firm Planned

4 101023 (1 Operation Simple Subcc

10 (Subcontracting)

4 101033 (3 Operations Subcontracir '

—
4 10000 ~
=0

)|

\

4 10000 4

10 (Cutting #1) m

20 (Subcontractor 1) lot033)0 |

Compact layout:

Visual Production Scheduler:  All -~ ‘ MNETRONIC VPS ~~ Open in Excel Actions Fewer options

bn Jan 25, 2021
Production Order
06:0] 12:00 AM| 12:00 PM

4 101033 (1 Operation Simple Subce

4 10000

|

10 (Subcontracting)

4 Firm Planned
4 101023 (1 Operation Simple Subco

¢
¢
e
4 10000 ey
=
.|
N
10103
¢
¢
¢

<> >

10 (Subcontracting)

4 101033 (3 Operations Subcontracir '
4 10000 | 4

10 (Cutting #1) m

20 (Subcontractor 1) 101033 |0

30 (Inspection Table #1)

p 101034 (3 Operations Subcontracir '

p 101035 (3 Operations Subcontra:
p 101036 (3 Operations Subcontra

kb ANANAL fCrmmaal I I A

= Choose a selection color
- Specify a tooltip delay: give a time in milliseconds after which the tooltip shall appear
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13. Usefilters

The VPS offers two kinds of filters, the difference between them lying in the time of application and
the data being used.

13.1. Data filters

Data filters work as Dynamics 365 BC filter on reading the data (either when the VPS is started or on
reloading) so that they are already effective at the data interface to make sure that only filtered data
are handed over from Dynamics 365 BC to the VPS.

13.1.1. Create and edit data filters

First, you have to open the according dialog by clicking "Choose Data Filter" in the "Setup" dialog:

Mew Actions Fewer options

Filter ~~

!F Choose Data Filter...

e B

In the dialog, you can edit, create and apply not only one but multiple data filters.

O Search  New E# Edit List [ Delete Show Attached [x:} Open in Excel Actions Fewer options
VPS FILTER CHOOSER /‘
NAME OWNER GROUP FILTERTYPE SUBCATEGORY
S ADMIN Individual User View
|Plan ned ) Company Wide Data
|ReTeased orders ADMIN Individual User View

To create a data filter, click “+New” and then enter the name of the new filter. To specify the filter
settings, click “Actions” “Edit Data Filter”.

O Search MNew B EditLlist [ Delete  Show Attached 8 Open in Excel
Yo edit Filter ) % Clear Filter
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You can filter by work center groups, work centers, machine centers and production orders:

EDIT - VPS FILTER IZ'
Work Center Group
Show results:
Where: | Code v is: | ~ |
And: | Name v is: | |

Work Center

Show results:
Where: | No. v s | v |
And: | Name v s | |
Machine Center
Show results:
Where: | No. v s | v |
And: | Name v is: | |
Production Order
Show results:
Where: | Status v | Released r
And: | No. v s | v |
And: | Description v o | |

e

If you want to make sure that the "Edit Data Filter “dialog pops up when you start the VPS, tick the
according option in the "Setup" dialog:

Filter

Show Data Filter on Start @
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13.2. View filters

View filters are applied to data already having been loaded into the VPS. Accordingly, only the
capacity utilization by the visible activities are shown in the histograms. To work with the filters, the
"Actions" menu offers three according options:

Actions~  Fewer options

General >
View Filter > | ¥ Choose View Filter...
Calendar > |+ Enable View Filter
Timescale > Disable View Filter I
View >
Administration >

13.2.1. Create and edit view filters

Click “Choose View Filter” to open the list of existing filters where you can create, delete and edit
filters as described in the “Data filters” section.

If you want to make sure that the last used view filter will be applied when you start the VPS, tick the
according option in the "Setup" dialog:

Filter

Show Data Filter an Stan ® Emable Last Used View Filter on Stan )
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14. Configure tooltips

The tooltips of the VPS provide further information on the following items of your production

schedule:

e production orders

e production order lines

e operations

e work center groups

e work centers

e machine centers

e planned and firm planned operations

released operations

You can specify which information is to be shown in the tooltip of the respective item in the "Tooltip"
dialog - to be reached by clicking "Configurations" in the “Actions” menu of the "Setup" dialog:

Actions Fewer options

Configurations

P Tooltip...

n

#% Label...

n- = 1 i =

In the dialog popping up, you select the item for which you want to customize the tooltip and then
either delete, edit or add fields and then click the “Edit” item from the “Actions” menu:

O Search X Open in Excel Actions Fewer options

VIEW - SELECTTOOLTIP

i
N
X

Description T

Production Order

Production Order Line

Planned and Firm Planned Cperations
Released Operations

Work Center Group

Work Center

Machine Center
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The dialog “Edit — Define configuration” pops up.

O Search  —+ New B2 Edit List [i] Delete A Move Up ¥ Move Down x(:} Open in Excel

i
it
N

EDIT - DEFINE CONFIGURATION

Production Order

Table Name Field Name
Production Order Description
Production Order Status

Production Order No.

Production Order Source Type
Production Order Source Mo.
Production Order Routing No.
Production Order Starting Date-Time
Production Order Ending Date-Time

Close

Here you can:

e Addanew field:
either click +NEW or just click in the last row. You can select the desired Dynamics 365 BC
data by clicking “...” either for table and field name.

AVAILAELE VALUES /‘
Value T
= Production Order

Production Order Line

e Insert a new field:
Select the field above which you want to insert a new one and proceed as described above.

e Delete afield:

Click "*“and select “Delete line”

=" New Line |
=2 Delete Line

M Select More I
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15. Configure bar labels
You can decide which D365 BC information is to be shown as bar label.
Bar labels are shown on

e operations in the Production View
e operations in the Capacity View

In the picture below, the bar label shows the production order number and the operation number,
separated by “|”.

10 (Subcontracting) 101023 | 10

You can specify which information is to be shown on the bar label of the respective item in the
according dialog to be reached by clicking "Configurations" in the "Actions“ menu of the "Setup"
dialog:

Actions Fewer options

Configurations ~~

7 Tooltip...
n

"~ /% Label...

n- L S| i =

In the "View - Select Label" dialog, select the item and/or view for which you want to customize the
bar label:

O Search X Open in Excel Actions Fewer options

VIEW - SELECT LABEL

i
N
X

Description T
Operation in Production View

Operation in Capacity View

Close
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The “Edit — Define Configuration” dialog pops up:

O Search - New B Edit List il Delete A Move Up ¥ Move Down [x:} Open in Excel

EDIT - DEFINE CONFIGURATION

i
v
Y

Operation in Production View

Table Name Field Name

Production Order Line Prod. Order No.
WPS Format Strings |

- |Produdion Order| e : timestamp

Close

Here you can add, insert, edit, and delete fields as well as change their order. You can select the
desired table name and field name from your Dynamics 365 BC data by clicking “...”

15.1. Formatting the labels

Separate the field contents by a line break, a blank or a “|” by selecting the according separator from
the “VPS Format Strings” table.

AVAILABLE VALUES

Value
MNew Line
Space

|

The separators can get enhanced by the function “Extendible bar text separator” that has to be
implemented by the partner. Please contact us for further information.

16. Configure table labels
You can decide which D365 BC information is to be shown as labels in the table for:

e Production orders

e Production order lines

e Production order routing lines
e Machine centers
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e Work centers
e Work center groups

The picture below shows the table label for a production order routing line, containing:

e the operation number
e ablank
e the description in brackets

10 (Assembly station #1)

16.1. How to proceed

For customizing the table label, proceed as follows:

e In both extensions click "Configurations" in the "Actions" menu of the "User Setup" dialog:

Actions Fewer options

Configurations ~
/% Tooltip...
|
| /% Label...

| S
#t Table...

e Inthe "View - select table text" dialog, select the item for which you want to customize the

table label which, in our case, would be "Production Order Routing Line":

2 Search [x:} Openin Excel Actions

VIEW - SELECT TABLE TEXT

Description 1
Production Order
Production Order Line

Production Order Routing Line

Machine Center
Work Center

Work Center Group

Fewer options

i
N
X

Close
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e The “Edit — Define Configuration” dialog pops up:

9 Search  —+ New B¥ Edit List lii] Delete A Move Up W Move Down [x:} Open in Excel

EDIT - DEFINE CONFIGURATION

Production Order Routing Line

Table Name Field Name

- Operation Operation Mo.

VPS Format Strings

Space
VPS Format Strings (
Operation Description
VPS Format Strings )

Here you can add, insert, edit, and delete fields as well as change their order. You can select the
desired table name and field name from your Dynamics 365 BC data by clicking “...”

16.2. Formatting the labels

Separate the field contents by a blank, or by the separators shown below by selecting the according
character from the “VPS Format Strings” table.

AVAILABLE VALUES

Value

Space

= NETRONIC
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17. Custom fields

In addition to the default fields available in tooltip, label and table text it is possible now to equip
custom fields with data to use them in tooltip, bar label and table text.

b-:ln-:l.a',-_. January 24,
]

0600 PM

Production Order

4 103001 Bicycle

4 10000 Production Order

Description: Bicycle

10 W Status: Planned
Ma.: 109001

20 CH source Type: Item
Source Mos 1000

30 Fiy Routing Mo 1000

40 o Starting Date-Time: 01/28/22 11:45 AM
Ending Date-Time: 01728722 04:00 PM
CustamField: CUSTOMFIELD INFO

Please find a detailed description in the related Knowledge Base articles:

How to add custom fields to the VPS
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18. Reload and save data

In case you wish to discard your changes after modifying the diagram (provided you didn’t save
them) you can simply reload the data of the diagram. The “General” items allow to reload the former

values or, alternatively, to store your modifications.

Actions~  Fewer options

General > | BB Reload
- View Filter > H save d
Calendar >
| Timescale >

Capacity Aggregation >

T View > |

—  Administration »

If there are unsaved changes in your plan when you click “Reload”, a dialog pops up where you can

decide whether to save these changes or discard them.

o Would you like to save changes in the production schedule?

s Mo
After having saved your changes, a confirmation message pops up:
o The production schedule has been saved successfully!

Ok
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The successful reload will be stated by another message box:

o The Data have been successfully reloaded

OK
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